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MMS7000 Profiler 

 
1. Warnings & Precautions 
Please read and understand this section fully before operating your MMS7000 Instrument. Failure to 
do so may result in damage to the instrument or personal injury. 
 

• To avoid electrical shock, never mount the sensor in a live motor 

• Ensure the sensor cable cannot be entangled with any moving or rotating equipment 

• Do not operate the instrument in an explosive environment 

• Use only the approved power adapter 

• Do not use alcohol or any organic solvent to clean the instrument 

• Only use the supplied stylus to avoid damaging the screen  
• The Sensor is a precise measuring device and should be treated with care at all times 

 
For information regarding the MMS7000 operating system, please refer to the MEZ1500 User Guide. 

 

2. Charging your MMS7000 
Ensure your MMS7000 is fully charged before use. To charge the device, connect the supplied USB 

communication cable to the bottom connector on the device, then insert the AC power adaptor plug 

into charging socket in the bottom left. The unit will not charge from a USB connection alone.  

  

3. Basic Operation 
The MMS7000 app is operated using the touchscreen. To select an option, you can tap firmly on the 

screen either with your finger or the included stylus. The stylus is made from black plastic and is 

stored in a slot in the top of the instrument on the right hand side.  

 

NOTE: If using something other than the included stylus, do not use anything with a sharp tip such 
as a pen or a metal tool! This will damage the screen and is not covered under your warranty. 
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4. Powering Up 

Power on your MMS7000 device  and wait for the Profiler7000 app to start. If the 

Profiler7000 app does not start automatically, you can start it yourself by double-tapping on the icon 

that appears on the Windows Desktop. 

    

5. Shutting Down 

Pressing the  button on the keypad again will put your MMS7000 into a low-power Sleep 

Mode. Sleep Mode allows you to press this button again later and wake up the MMS7000 instantly, 

right to where you left off. However Sleep Mode still uses a very small amount of battery power and 

if the MMS7000 is left in this mode the battery will eventually go flat, typically in 5-7 days.  To 

completely power off the MMS7000 for longer term storage use the System Menu as described later 

in the section Using the System Menu.  

6. The Home Screen 
The Home Screen of the Profiler7000 app will now display: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

Battery Level 

Measure 

Review 

Options 

Available Data 

Storage Space 

System Menu 
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The Home Screen offers 3 main options: 

Option  Functions 

   
Measure 

Tap Measure to take recordings with your MMS7000. 
 
This is described in the section Measuring 

 
Review 

Tap Review to review the previous Recordings stored on the device. 
 
This is described in the section Reviewing Recordings 

 
Options 

Tap Options to view and alter the basic settings on your MMS7000. 
 
This is described in the section Setting Up Your MMS7000 

At the bottom of the screen are also 2 icons showing the current battery level of your MMS7000, 

along with how much data storage space is still available.  

7. Setting Up Your MMS7000 

Tap the   Options icon to display the Options screen to review and change device settings. 

NOTE: Due to ongoing product development, the design and capabilities of the sensor electronics 
hardware inside MMS7000 devices has advanced over time. This means that some features are 
available only if the Hardware Version of your MMS7000 device (as shown on the Options → 
System tab) meets the minimum requirements. Contact Profiler Tech Support for more information 

 

 

At the top of the screen is the unique Device ID number for your MMS7000. This ID cannot be 

changed but you may need it when contacting Profiler Tech for technical support. 
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Below that are tabs allowing you to view and change the following settings: 

Tab Description 

Preferences  The Units settings allows you to switch the display between metric and imperial 
measurement units throughout the Profiler7000 app e.g. 

    
Audio Allows you to specify if you want an audible beep every time you tap the screen. 

Default is On. 

Sensor 
 

Allows you to specify details of the Profiler Sensor connected to your MMS7000: 

• Wheel Diameter: In order to provide the most accurate recordings, the 
Profiler7000 app needs to know the precise diameter of the wheel on the 
sensor you are using.  This should be measured using a Micrometer or Vernier 
Calipers on the part of the wheel that is in contact with the commutator or 
slipring during measuring:  

 
The default Wheel Diameter is 7.85mm/0.309 inches. 

(continued) 

Measure Here 

Wheel Diameter 
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Sensor 
(continued) 

• Sensor Auto Off (seconds) [Hardware Version 2.0 or later only] 
If the sensor remains idle for longer than the specified period, it will be 
automatically powered off to save battery (it will be automatically 
powered back on later whenever it is required). Note that if the sensor is 
powered on, a red LED will be visible in the small window above the 
sensor connector: 

 
System Displays version and serial numbers of the various components of your MMS7000 

for your reference: 

• Module [Hardware Version 2.0 or later only]: the serial number of the black 
data acquisition module at the top of your MMS7000 where the sensor 
connects. 

• Software: The version of the Profiler7000 app currently running on the device  

• Hardware: The version of the data acquisition module.. 

• Firmware: The version of the embedded firmware running on the data 
acquisition module.  

• Firmware Update Button [Hardware Version 2.0 or later only]: When enabled 
(green), when you install a new version of Profiler7000 app it will 
automatically also update the data acquisition module firmware for you if 
required.  
However, you can also use this Firmware button to manually update the 
firmware to a specific version, but this should ONLY be done under the 
direction of the Profiler Tech Technical Support team.  

When you have finished setting options, tap    to save your changes and return to the 

Home Screen.  
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8. Taking Recordings 
Connect the Profiler Sensor to the connector on the top of the MMS7000 device. Ensure the Plug 

and Socket key aligns before tightening the locking ring.  

 

Tap the    Measure icon on the main screen, and the Measurement Setup screen will be 

displayed: 

 

The Measurement Screen allows you to change the following settings: 

Option Description 

Machine Type 

Continuous 
 

Allows you to specify if the machine you are measuring is one 
smooth/continuous surface (such as a slip ring).  

Bars/Segments Allows you to specify if the machine you are measuring has discrete 
bars/segments (such as a Commutator) 
This setting simply controls whether the MMS7000 device will need to detect 
Bar-to-Bar displacement or not. 

Recording Stop 

Manual Stop Indicates that the recording will continue until you manually stop it yourself 
using the Stop Recording button. 

(continued) 
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Auto Stop after - 
xx mm 

Enter the Rotor circumference measurement and the MMS7000 will 
automatically stop the recording at this dimension. 
Note: The maximum measuring distance currently supported by the 
MMS7000 corresponds to a single revolution of a rotor with a 2m (6.5 feet) 
diameter, which is ~6.3m (20.4 feet) 

xx Bars 
 

Specify how many Commutator bars/segments and the MMS7000 will 
automatically stop the recording at the specified number of bars. 

Measuring exactly 
1 revolution 
 

Check this box if you plan to rotate the commutator through exactly one 
revolution.  
If this option is checked: 

• If you also specify a value for “Auto Stop after” (above), the 
MMS7000 will know exactly how far the sensor wheel will need to 
travel to complete 1 revolution and so you will get the option to 
display a live Radial plot while you are recording 

• For Bar recordings, the MMS7000 will presume that the last bar 
measured is physically adjacent to the first bar, and so will compare 
their heights when calculating MBTB. 

 
Uncheck this option if you intend to measure more (or less) than exactly 1 
revolution. The option to view a Radial plot while recording will not be 
available, and for Bar recordings the MMS7000 will not include the height 
difference between the first and last bars when calculating MBTB 

 

Tap    to continue to the Position Sensor screen. 

 

 

Position Sensor 
Remove the sensor from its protective metal sleeve and position it squarely 
in a brush holder on the machine to be measured. To ensure greatest 
accuracy and correct operation, the rotor must be rotated from the clamp 
side to the rear of the sensor, as shown on the right. 
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Since the sensor is usually smaller than the brush assembly, you 
will need to insert packing material at the front and back of the 
sensor to take up the available space in the brush holder. This can 
be either the spacer kit supplied in the kits (as shown to the left), 
scrap plastic or Teflon etc offcuts, or any other suitably hard 
material you have available.  
 
Once you have taken up all the spare space in the holder, secure 
the sensor in position by lightly tightening the clamping knob. 
 

DO NOT clamp the sensor with a mechanical clamp: this may 
cause crush damage to the internal electronics. 

 
 
 

  
NOTE: If measuring a machine with discrete Bars/Segments, it is 
important that the first few bars are measured correctly as 
these initial bars help tune the detection algorithm for the rest 
of the recording. For best accuracy, please ensure that the 
recording starts with the sensor positioned in the middle of a 
bar face, and that the starting bars have good surface condition 
and have no high mica 

 
Once the sensor is mounted, use the dial gauge indicator on the 
Position Sensor screen to fine-tune its position so that the indicated 
Displacement is as close to zero (the sensor’s midpoint) as practical, 
then tighten the clamp.  
 

The displayed value does not need to be exactly 0 to give accurate results, and an acceptable 
position will be indicated by a dial indicator having a green surround, whereas yellow and red 
indicate poor positioning.   
 

Once the sensor is positioned, tap    to continue to the Measuring Screen. 
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Measuring  

Once the sensor is in position, tap    to start recording. Slowly rotate the rotor being 

measured, and the profile data will be displayed on the screen as described below: 

 

Option Description 

Segments The number of displacement samples the MMS7000 device has taken so far. A sample will be taken 
for every ~0.5mm of travel around the machine circumference, although this will vary slightly 
depending on the sensor wheel diameter entered in Section 4:  Setup Options. 

Distance The distance the sensor has travelled around the surface of the rotor so far. 

Speed The current speed of the sensor wheel as it travels around the rotor.  
 
If the Speed value is displayed in red, this indicates you are rotating the 
machine so quickly that the sensor is acquiring profile data faster than 
the MMS7000 can update the display. 
 
If this happens, simply slow down the rotation until Speed returns to 
being displayed in black and then continue with your recording – no 
profile data will be lost 
 

Current The current sensor displacement, relative to the 0 point of the start of recording  

Bars [For Bars/Segments recordings only]  
Total number of bars counted so far 
 

NOTE: When recordings Bars/Segments, the adaptive nature of the bar detection system will cause 
the MMS7000 display (including Bar Count) to lag behind the physical position of the sensor by 
approximately 2.5mm (1/10th inch).  To ensure the recording includes the final bar in the recording, 
either: 
- Ensure that the sensor wheel has travelled at least 2.5mm (1/10th inch) past the gap after the 

last bar you want to measure before you stop recording, or  
- Simply use the “Autostop” feature to have the MMS7000 continue recording until it detects the 

desired number of bars and then automatically stop. 
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During recording you can cycle through different ways of displaying the live profile data: 

• Tap  to show a Line or Bar graph (depending on whether you are taking a 

Continuous or Bar recording)  

• Then tap  to view the profile as a Radial plot.  

Note:  

o The Radial plot view is only available if you have entered a value for “Auto Stop 

after” on the Measurement Setup screen prior to starting the recording, as this 

distance is used to correctly determine how far through the full 360 degrees the 

recording currently is. 

o Drawing the Radial plot in real-time is very resource intensive on the MMS7000 

handheld and so you may notice some amount of lag updating the display when 

using it, especially for fast and/or long recordings, but note that no data will be lost.   

• Finally, tap  to return to the original display showing numeric values.  

To stop the recording, tap  , or if using Auto Stop, simply continue measuring: the 

recording will automatically stop once the pre-set number of Bars or Distance has been recorded.  
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Measurement Complete  
 

 

Once the measurement is complete the data is displayed on the screen as described below: 

Option Description 

Distance/Bars For Continuous recordings: the total distance the sensor wheel travelled during the 
recording 
For Bar recordings: the total number of bars counted during the recording 

TIR The Total Indicated Runout, the displacement difference between the highest and 
lowest measured points on the machine surface.  

[For Bar recordings only]: 

MaxBTB The Maximum Bar-To-Bar displacement, which is the largest displacement difference 
between any two adjacent bars in the recording.  

MeanBTB The Mean Bar-To-Bar displacement, which is the average/mean displacement 
difference between each pair of adjacent bars. 

You can now select one of the following actions: 

Option Description 

 

Go back to the Position Sensor screen to take the measurement again. 

 

[Bar recordings only]: View the Bar Group Statistics for the recording (see below)  

 

View a graph of the recording that was just taken. You can pan and zoom on this recording 
using the Up, Down, Left, and Right keys on the keypad.  

 

Save the recording so it can be imported into EVOsoft desktop software for analysis and 
reporting 

 

Go back to the Home Screen without saving the recording. 
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Bar Group Statistics  
For Bar recordings, the Bar Group Statistics page helps you evaluate the condition of the commutator by 

looking at groups of consecutive bars in the recording.  

 

To set the bar group size, tap the Bar Group Size button and enter the number of consecutive bars you 

wish to evaluate. In the example shown above, the MMS7000 is analyzing each group of 10 consecutive 

bars (e.g. bars 1-10, then 2 -11, then 3-12 etc.)  

Once Bar Group Size is set: 

Field Description 

Largest Mean 
BTB 

Identifies the group of consecutive bars with the largest Mean Bar To Bar displacement 
difference. In this example, the 10 bars from 30 to 39 have the largest Mean BTB at 
20µm. 

Average for 
all groups 

The average Mean Bar To Bar for all other groups of consecutive bars for comparison. 
In this example, each group of 10 consecutive has (on average) a Mean BTB of just 
11µm, meaning the group from bars 30 to 39 is almost twice the average for this 
commutator. 

Largest TIR Identifies the bar group with largest Total Indicated Runout i.e. the largest difference 
between tallest and shortest bar in that group. In this example, this is also bars 30 to 39 
with a TIR of 177µm 

Average for 
all groups 

The average TIR for all other groups of consecutive bars, which in this example is 74µm. 
This means that bars 30 to 39 have a runout almost 2.5 times higher than other groups.  
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Re-Record Profile 

To re-measure, tap  to return to the Position Sensor screen ready to measure another profile.  

 

Save Recordings 

Tap the  Save Icon to continue to the Save Recording Screen. 

 

The saving options are displayed on the screen as described below.  

Option Description 

User Select the name of the User who took the recording from the list. 

 
Folder Select a Folder from the list, or tap in the Folder field and then tap   to enter a new 

Folder name  

 
Machine Select a Machine from the list, or tap in the Machine field and then tap  to enter a 

new Machine name 

 
Notes Select an existing Note from the list, or tap in the Notes field and then tap  to enter a 

new recording Note.  
If you enter a note and tick the ‘Add this note to the List’ checkbox, you Note will be added 
to the list and be available when saving future recordings  

 

The items in the Users, Folders, Machines, and Notes lists are able to be defined and edited in 

EVOsoft. (See the User Names and Recording Notes sections, below) 

Once the Folder and Machine details are selected, tap    to Save the data. 
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Creating a Group of Recordings 
When saving a recording for the same Folder and Machine as the previous recording, you are 
offered the option of grouping the 2 recordings together: 
 

 

If you select Yes, then the recordings will be grouped together so that whenever you display one of 

the recordings later in EVOsoft, the other(s) will automatically also be shown on the same plot. This 

is useful when you are recording multiple tracks on the same rotor.  
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9. Reviewing Recordings 

Tap the  Review icon on the main screen and the list of Recordings stored on the device will 

be displayed. 

  

Saved recordings are displayed by Folder, Machine name and Date stamp.  

Option Description 

 

Go back to the Home Screen  

 

Tap on a Recording timestamp and then tap this button to delete this recording. 

 

Tap on a Recording timestamp and then tap this button to view the details of the 
selected recording 

 
10. Interpreting Profiles 
Surface condition and acceptable levels of ovality are usually recommended by the OEM. However 

the general industry rule of thumb for determining acceptable conditions of commutators is as 

follows:  

Machine Condition Total Indicated Runout (TIR) Maximum Bar-to-Bar (MBTB) 

New Less than 40 microns (1.5 mil) Less than 5 microns (0.2 mil) 

In service Less than 75 microns (3.0 mil) Less than 10 microns (0.3 mil) 

 
Machines exhibiting greater values are generally deemed to require repair. Note that:  

• ‘mil’ is the US term for one thousandth of an inch i.e. 1 mil = 0.001”  

• ‘micron’ is the term for one thousandth of a millimeter i.e. 1 micron = 0.001mm  

• 1 mil = 25.4 microns or 0.0254mm, and conversely 1 micron = 0.039 mils  

 



   Copyright 2017 Profiler Tech Ltd  20 

11. Using the System Menu 
Tap on the System Menu icon at the top left of the main screen to bring up the System Menu: 

 
On this menu: 

Menu Entry  Functions 

 

Tap Exit to close the Profiler7000 application and return to 
the Windows Desktop. You can restart the Profiler7000 app 
again later by double-tapping on it’s icon on the Windows 
Desktop. 

 

Tap Power Off to completely power off the MMS7000, meaning it will use 

no battery power at all. However, when you press the  button on 
the keypad to turn it on again later, you will need to wait for the device to 
completely reboot, which typically takes ~30 seconds.  
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12. Upgrading the Profiler7000 App  
 
Profiler Tech periodically makes new versions of the Profiler7000 app publicly available at 
www.profilertech.com, and these new versions can be applied to any MMS7000 device at no charge.  
 

NOTE: While updating the Profiler7000 app should not result in any loss of data, it is strongly 
recommended that you import all recordings stored on the device into EVOsoft before updating 
the app. 

 
The version of the Profiler7000 app you currently have installed is shown on the Options → System 
tab. Installers for new versions of the Profiler7000 app are provided in standard Windows .zip files 
named Profilertech.Profiler7000.Setup.vX.X.X.X.zip, where X.X.X.X indicates the version number 
e.g. Profilertech.Profiler7000.Setup.v18.7.1.1.zip  
 
To upgrade your instrument with a new version: 

1. Download the .zip file for the required version and save it on your PC e.g. on the Desktop.  
2. Extract the single Profilertech.Profiler7000.Setup.CAB file contained in the .zip file and save 

it somewhere on your PC. 
3. Connect your MMS7000 to your PC and copy this .CAB file to  

\Storage Card\Profilertech\Software, overwriting the existing file: 

 

4. Once saved in this location, perform a hard reset of the MMS7000 by pressing both the 

power button and the corresponding button on the other side of the device for 3 seconds 

until the display turns completely white, then release the buttons and wait for the re-boot to 

complete.  

 

After the MMS7000 reboots, the new version of the Profiler7000 app will be automatically installed 

and the device should now be ready for use.  

http://www.profilertech.com/
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EVOsoft Analysis Software 

13. Installing EVOsoft 
 

The installer for EVOsoft is provided on the USB Memory Stick supplied with your MMS7000. 

Installers are supplied in a standard Microsoft Windows .zip file named EVOsoft.Setup.vX.X.X.X.zip, 

where X.X.X.X indicates the version number e.g. EVOsoft.Setup.v18.6.23.2.zip.  

Each such .zip file contains a single standard Microsoft Windows .msi Installer file with the same 

version number e.g. EVOsoft.Setup.v18.6.23.2.zip contains EVOsoft.Setup.v18.6.23.2.msi. 

 

To install:  

1. Extract the .msi file from the .zip file and save it somewhere on your PC e.g. on the desktop 

2. Double-click the .msi file and follow the instructions to complete the installation 

 

To start EVOsoft, double-click on the desktop icon or manually start the program in: 

Start → All Programs → Profiler Tech Ltd → EVOsoft 

 

14. Upgrading EVOsoft 
Profiler Tech also periodically makes new versions of EVOsoft publicly available at 

www.profilertech.com, and these new versions can be installed by any user at no charge. 

 
NOTE: While updating EVOsoft should not result in any loss of data, it is strongly recommended 
that you make a backup of your EVOsoft databases prior to installing the update (see the Database 
Backup section, below) 

 
To upgrade EVOsoft on your PC, follow the instructions in the Installing EVOsoft section, above, and 

your existing EVOsoft installation will be updated to the new version.  

 

Some new versions of EVOsoft include changes to the underlying database and if so, the first time 

you open an existing database after installing an update you will be prompted to upgrade it e.g.: 

 
Simply click ‘Yes’ to upgrade the database as required, but note that once this is done, you will no 
longer be able to open that database with older versions of EVOsoft.  
 

  

http://www.profilertech.com/
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15. Installing Device Communication Utilities 
Before EVOsoft can communicate with your MMS7000 device, standard Microsoft device 

communications utilities must be installed on your PC. The specific utility required will vary 

depending on which version of Microsoft Windows you are using: 

- For Windows XP: Microsoft ActiveSync 4.5  

http://www.microsoft.com/en-nz/download/details.aspx?id=15 

- For Windows Vista, 7, & 8: Microsoft Windows Mobile Device Center 6.1 

https://www.microsoft.com/en-nz/download/details.aspx?id=14 

- For Windows 10: Microsoft Sync Center should be automatically enabled and configured for 

you when you first connect the MMS7000 via USB cable, although this may take a few 

minutes and your PC will require an internet connection.  

 

The standard Microsoft installers for these products are included on the USB Memory Stick supplied 

with your MMS7000. Alternatively, the installers (along with supporting documentation from 

Microsoft) can be downloaded at the links above. 

 

16. Connecting Your MMS7000 to your PC 
Once you have installed the appropriate Microsoft Device Communication Utility, connect your 

MMS7000 to a USB port on your PC. After a brief initialisation period, the Windows Mobile Device 

Center window will appear (if it does not, refer to the Troubleshooting section of this document):   

 

 
  

http://www.microsoft.com/en-nz/download/details.aspx?id=15
https://www.microsoft.com/en-nz/download/details.aspx?id=14
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In the screen above, select Set up your device. When asked what items you want to sync with this 

device, ensure all boxes are unchecked: 

 

Click Next to display this window: 

 

Give your device a name (e.g. MMS7000) and then click Set Up. Once the setup process is 

completed, you can safely close the Windows Mobile Device Center window by clicking the X in the 

top right corner.  

  



   Copyright 2017 Profiler Tech Ltd  25 

17. Activating your EVOsoft License 
EVOsoft can be freely installed and used without a licence in limited Trial mode, although a number 

of key functions will be disabled such as importing data from existing EVOsoft and Commtest Profiler 

MAS databases, as well as exporting data to other EVOsoft databases. A valid EVOsoft license is 

required to unlock these functions and this is included with the purchase of all new MMS7000 

instruments. Your EVOsoft licence serial number will be emailed to you by Profiler Tech Support, and 

is in the format of a sequence of letters and numbers, similar to the below:  

1F25-8C5F-C26D-4246-AA08-9D1C-2837 
[Note that the number above is an example of the format only: your specific licence serial number will be 

supplied with your MMS7000 Kit] 

Before you can use your EVOsoft license you need to install and then Activate it on your PC. Your 

license will come with 3 Activations, meaning you can use it on up to 3 different PCs.  

To activate your EVOsoft license on a PC: 

1. Ensure your PC is connected to the internet: while EVOsoft does not require an internet 

connection during normal operation, a connection is required for this initial license activation. 

Contact Profiler Tech Support if this is not possible for you.  

2. Start EVOsoft and from the menu select Help → Licensing… to display the EVOsoft Licensing 

window, which will initially show that no valid license is installed and EVOsoft is running in Trial 

mode: 

 
3. Enter your EVOsoft license serial number in the Serial Number field, then click Activate. 

4. If the license is activated OK, the EVOsoft Licensing window will close and you will be returned to 

the main page. If you receive any sort of error that you are unable to resolve, contact Profiler 

Tech Support.  

5. To verify your license status at any time, select Help → Licensing… to display the EVOsoft 

Licensing window again, which should appear similar to the following:

 

  



   Copyright 2017 Profiler Tech Ltd  26 

18. Create Database 
To commence using EVOsoft, you must first create a database.  

 

Select Create a New Database, browse to the preferred Folder Location and enter the File Name of 

the new database.  

Select Open to create the database.  

Once a Database has been created, it can be selected from the dropdown option in:  

Use a Previous Database or use Browse for an Existing Database to select. 

 

 

19. EVOSoft Software layout  
 

 

  

Navigator 
Displays Folders & their 

Machines 

Lists the currently 

displayed Recording(s) 

Recording Details 
Information for the 

selected recording 

from the top right 

Plot Section 
Displays all Recordings in the 

Showing Recordings list using the 

various plot options 

 

Plot movement 

controls 

Recording List 
Displays all Recordings for 

the Machine selected in 

the Navigator 
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To select another Database, click File, select Open Database and browse to the file location. 

 

20. Folders & Machines 
A database can contain multiple folders, each folder can contain multiple machines, and each 

machine can have multiple recordings.  

Right click in the Navigator Window to create a new Folder. Enter the Folder details and select OK. 

Enter a description if required. 

 

To add a new Machine to the Folder, Right Click on the Folder and select Create New Machine. 

 

You can enter the Machine name, a description and information on the machine type – Continuous 

or the number of Bars. 

 

You can also copy an existing Machine to a different Folder: 

1. Right click on the Machine you want to copy and select Copy Machine. If this Machine also 

has some recordings attached to it, you can choose to also copy these as well if desired.  

2. Right-click on the Folder you wish to create the copy in, and select Paste Machine.   
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21. MMS7000 Communications 
Connect the USB Comms cable between the MMS7000 and USB port of the PC. The MMS7000 will 

automatically connect to the EVOsoft software, and a green confirmation message will appear in the 

bottom right hand corner: 

 

If EVOsoft is unable to detect that your MMS7000 device has been connected to the PC, consult the 

Troubleshooting section, below.  

22. Transferring Data 
Once communication is established, to transfer recorded data to EVOsoft, click MMS7000 Device 

from the Toolbar and select Connect… 

 

The Device Connected Window will appear listing all recordings available for download e.g. 



   Copyright 2017 Profiler Tech Ltd  29 

 

Choose the desired recordings to be imported by selecting the checkbox. The Device Connected 

window also allows you to manage the Selected Recordings stored on the MMS7000 device: 

Selecting… Then pressing ‘Sync’ will… 

Import then remove from 
MMS7000 

Import the recordings into EVOsoft and then delete the 
recordings from the MMS7000 device. 

Import but leave on MMS7000 Import the recordings into EVOsoft without deleting them 
from the MMS7000. 

Remove from MMS7000 without 
importing 

Delete them from the MMS7000 device WITHOUT 
importing them into EVOsoft. Once a recording is deleted 
like this it cannot be recovered, so take care to ensure 
that you are deleting the correct recordings. 

 

During the synchronisation operation, you can also send other types of data to the MMS7000: 

Selecting the option… Will … 

Machines & Folders Send the list of Folders and Machines from the EVOsoft 
database you are currently viewing to the MMS7000 
handheld. 

Notes Send the list of Recording Notes from the EVOsoft 
database you are currently viewing to the MMS7000 
handheld. Refer to Section 0 for more details on defining 
Recording Notes.   

User Names Send the list of defined Users from the EVOsoft database 
you are currently viewing to the MMS7000 handheld. 
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All of the options are checked by default and all of the above information is then available to select 

when saving recordings on the MMS7000, as described in Section 9, above. 

The entries in both lists will appear on the MMS7000 in the same sequence they appear in EVOsoft 

in the two displays above. To change the current sequence, select an entry and then click Move Up 

or Move Down as required.    

23. Plot a Recording 
To plot a recording, simply double-click the recording in the Navigator List in the lower left corner, or 

right-click on the selected recording and then select Show on Chart. 

 

There are six Plot types available to display the data, which are selected using the appropriate Chart 

Tab at the top of Plot Section. Once a profile is plotted, you can toggle through the Tabs to view the 

recording in each of the different Plot types, as described on the following pages. 
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Shape Plot 
Profiles are displayed in a linear form, showing either the raw shape of the recording (for Continuous 

recordings), or the individual Bars (for Bar recordings).  

 
To read values from the displayed data within a Shape plot, left click on bar and hold the mouse 

button down. The Bar number and amplitude or position (Degrees) and amplitude will be displayed. 

 

Below the main plot is a smaller chart that shows the Displacement Rate of Change (for Continuous 

recordings) or the Bar-to-Bar Change (for Bar recordings). This helps you to identify areas of the 

rotor where the shape is changing in an abnormal manner e.g. unusually steep upwards or 

downwards slope, oscillating bar heights etc. 

 

By default, Shape Plots are drawn with a horizontal dotted line that indicates the average 

displacement for the recording, although this line can be turned on and off by right-clicking on the 

chart and selecting the Show Average Line menu entry. Bar Plots also include a vertical dotted line 

indicating the position of the MBTB value, which can similarly be turned on and off by right-clicking 

on the chart and selecting Show MBTB Line.  
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Radial Plot 
Profiles are displayed in a radial form which displays the true shape of the Commutator or Slip Ring, 

although with a highly exaggerated displacement to better show the detailed shape.  

 

The upper and lower limits of the chart default to fixed values to give a consistent initial view of all 

rotors, but these limits can be changed as described in the Y-Axis Scaling section, below. As for the 

Shape Plot, Radial Plots are drawn with a circular dotted line indicating the average displacement for 

the recording which can be turned on and off by right-clicking and selecting Show Average Line. For 

Bar recordings, a dotted straight line indicates the position of the MBTB values which can also be 

turned on and off by right-clicking on the chart and selecting Show MBTB Line. 
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Bar Group Stats  
Used for Bar recordings only, the Bar Group Stats plot is like the Radial Plot in that it shows the 

profile in a radial form, but also allows you to view statistics about each group of consecutive bars in 

Bar Recordings.  

 
 

The number of bars in each group can be adjusted using the Bar Group Size field and in this 

example, it is set to 5 so EVOsoft is analysing each group of 5 consecutive bars i.e. bars 1-5, then 2-6, 

then 3-7 etc. 

 

Once Bar Group Size is set, the plot then identifies which group(s) of consecutive bars has: 

• The largest Mean Bar-To-Bar height difference between consecutive bars in the group 

(identified by the dotted line in the inner part of the plot) 

• The largest Total Indicated Runout between the tallest and shortest bar in the group 

(identified by the dash-dot line in the outer part of the plot) 

  



   Copyright 2017 Profiler Tech Ltd  34 

Bar-to-Bar Histogram 
Used for Bar recording only, this plot summarizes the Bar-to-Bar height differences for all bars in a 

Bar Recording by plotting them in a histogram.  

 

The resolution of the histogram can be adjusted using the ‘BTB Resolution’ field and the plot will 

automatically update.  In this example the resolution is set to 1µm (1 micron) and for this bar 

recording: 

- 4 pairs of bars have a BTB difference between 0 and 1µm 

- 13 pairs of bars have a BTB difference between 1 and 2µm 
- 5 pairs of bars have a BTB difference between 2 and 3µm, and so on.  

A vertical dotted line indicates the exact Mean BTB displacement difference, and this lines can be 

turned on and off by right-clicking on the chart and selecting the Show Average Line menu entry. 

Note that this line shows the exact Mean BTB displacement, whereas the Mean BTB value shown in 

the chart legend is rounded.   
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Shape Data  
Displays the actual value recorded in steps of 0.5mm as the sensor travels across the surface of the 

rotor. This view allows you to copy the recorded data to the Clipboard so that you can paste it into 

other programs, such as Microsoft Excel. To do this: 

1. Select all the rows of data by left-clicking in the empty cell in the very top left corner of the 

page 

 
2. Right-click in this same cell and select ‘Copy to Clipboard’ 

3. Switch to the program you want to paste the data into and use the normal Paste 

functionality to paste in the data  

 

Bar Data 
Displays the actual value recorded on each bar or segment. You can copy the data from this view 

into other programs using the same method described for ‘Shape Data’, above.  

24. Change Default Units & Position 
Select the Setup Menu to customise how you want certain things displayed: 

 

Selecting the option… Allows you to … 

Show Position In…  Specify whether the X axis on charts and other values related to the 
position of the sensor on the rotor will be displayed in millimetres, 
degrees or inches. 

Show Displacement In… Specify whether the Y axis on charts and other values related to the 
measured displacement (e.g. TIR, MBTB etc) will be displayed in 
millimetres, microns or mils (1/1000th of an inch). 

Chart Options Set the default line style and thickness for charts.  
Note that once a recording has been plotted on a chart, the color 
and style of it’s plot lines can be individually adjusted as described 
in the following section.  
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25. Plot Multiple Recordings 
You can add multiple recordings to a graph - right click on a recording in the bottom left and click 

Add to chart.  

 

The recording will then be added to the Showing Recordings list in the top right, and the colour of its 

name in this list will match the colour of the corresponding line in the Plots e.g. 
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26. Plotting a Recording Group 
Section 0 – “Creating a Group Of Recordings” (above) describes how to group related recordings 

together when using the MMS7000. Once these recordings are imported into EVOsoft, when they 

are displayed in the recording list in the bottom left, any recording that is in a group is displayed in 

bold text, and you can also expand the recording item in the tree to see the details of the group(s) it 

is in: 

 
Double-clicking on the recording machine name & timestamp will display just the individual 

recording by itself as normal, but double-clicking on the Recording Group text (“Track Group (2)” in 

this example) will display all of the recordings in the group at the same time. 

In addition to creating ‘Track Groups’, when recording on the MMS700, you can also manually create 

a ‘Custom Group’ in EVOsoft by manually adding & positioning recordings on the charts and then 

right-clicking in the ‘Showing Recordings’ list in the top right and selecting Save Recording Group…: 

 

You can use the same method to add or remove recordings from an existing Recording Group of 

both types, and note that if you remove recordings from a Group such that only 1 recording remains, 

the Recording Group will be automatically removed. 
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27. Recording Information 
Once a recording has been plotted, its details will be displayed 

in the bottom right of the display: 

 

 

 

 

 

 

 

 

The details displayed are: 

Field Description 

Folder The Folder the recording is from.  

Machine  The Machine the recording is for 

Type The Type of recording: either ‘Bars’ or ‘Continuous’  

Recorded The date and time the recording was taken 

By If specified during recording, the name of the person who took the recording.  

Min/Max The minimum and maximum displacement measured during the recording i.e. the highest and 
lowest points found. 

TIR The Total Indicated Runout; the difference between the minimum and maximum 
displacement. For Bar recordings, the numbers of these highest and lowest bars is also shown.  
Note: If multiple bars share the same minimum (or maximum) displacement, then the lowest 
numbered bar will be shown.  

For Bar recordings only 

No. Bars The total number of bars detected 

Max BTB The Maximum Bar To Bar displacement; the maximum displacement difference between two 
consecutive bars, along with the numbers of these two bars 
Note: If multiple pairs of bars share the same Maximum BTB displacement, then the lowest 
numbered pair of bars will be shown.  

Mean BTB The Mean Bar To Bar; the average displacement difference between each pair of consecutive 
bars for the entire recording 

If multiple recordings are being displayed, you can choose one to display details for by selecting it in 

the Showing Recordings list in the top right of the display. To help you keep track of multiple 

recordings, the field in the Recording Details section will use the same colour used for that recording 

in the Showing Recordings list and for lines on Plots.  
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28. Add Comments 
In the bottom right corner of the main EVOsoft display are 2 text fields containing text descriptions 

related to the currently select Recording: 

  

• Recording Notes is the text entered on the MMS7000 device when the recording was saved, as 

described above in the section Save Recordings, above. These Recording Notes cannot be 

changed in EVOsoft 

• Comments allow the EVOsoft user to enter free-form text that is stored along with the recording. 

Click in the comments field to open the Edit Comments window where you can add or edit 

recording comments, including pasting text in from other applications:  
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29. Altering How Recordings Are Displayed 
Changing Chart Colors and Lines 
When a recording is added to a chart, the corresponding plot line will use the default line style and 

thickness specified in the Setup menu (see above) in the next unused color. However, you can then 

adjust the color and style of this line by right-clicking on the recording in the ‘Showing Recordings’ 

list in the top right and selecting ‘Line Color & Style…’ 

 

This is useful if you wish to print a chart on a monochrome printer as it allows you to set all plot lines 

to black and instead just assign each recording a different line style.   
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Moving Recordings 
When displaying multiple recordings on a single plot, it is often useful to be able to adjust the 

position of the recordings up/down or left/right. This is most useful for aligning profiles recorded on 

the same machine but with different starting positions on the same plot, and is available for both 

Shape and Radial Plots using the Move Selected Recording buttons: 

 
 

First choose which plot to move by selecting the Recording in the Showing Recordings list in the top 

right, then adjust its position using the 8 buttons as follows: 

 

Button Moves the Recording… Keyboard Shortcut Mouse Shortcut 

Shape Recordings Bar Recordings 

 
Left by 10 samples Left by 10 bars Shift + Left Arrow Ctrl + Shift + Mouse 

Wheel Up 

 
Left by 1 sample Left by 1 bar Left Arrow Ctrl + Mouse 

Wheel Up 

 

Right by 1 sample Right by 1 bar Right Arrow Ctrl + Mouse 
Wheel Down 

 

Right by 10 samples Right by 10 bars Shift + Right Arrow Ctrl + Shift + Mouse 
Wheel Down 

 
Up by 10 microns (0.01mm) Shift + Up Arrow Shift + Mouse 

Wheel Up 

 

Up by 1 micron (0.001mm) Up Arrow Mouse Wheel Up 

 
Down by 1 micron (0.001mm) Down Arrow Mouse Wheel 

Down 

 
Down by 10 microns (0.01mm) Shift + Down Arrow Shift + Mouse 

Wheel Down 

 

Zoom & Pan 
Zooming is only available in Shape plots: 

• Zoom in - Left mouse click and hold, draw a box over the target area. Release the mouse 

button to zoom in on the target area. You can zoom in multiple times. 

• Zoom out – Click down on middle mouse button or click down on your scroll wheel, or right-

click on the chart and select the Zoom Out menu entry. You can zoom out as many times as 

you zoomed in. 

• Pan – The chart display can be dragged in any direction to display areas that are hidden in 

the current view which is especially useful once you have zoomed in. Pan the display by 

holding down the right mouse button and dragging the chart.  
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Y-Axis Scaling  
In the Shape and Radial Charts you can change the Y-Axis scale by clicking on the chart and rotating 

the scroll wheel on your mouse. Holding down the Shift key while you scroll changes the scale 

faster.    

Reset Chart Display  
To undo all moving, zooming, panning and scaling of a chart and reset it back to its original 

appearance, right-click on the chart and select the Reset Chart menu option.  

30. Copying & Printing Charts 

 

To copy a chart to the Windows Clipboard, right-click on the chart and select Copy to Clipboard. 

Once copied you can paste the chart image into reports, documents or emails.  

31. Generating Reports 
EVOsoft includes the ability to generate a comprehensive recording report in Microsoft Word 

(*.docx) format. Each report can include any of the 5 different report pages available, as described 

below. 

Recording Summary Page 
This page contains a table showing the details of the recording(s) as shown in the Recording Details 

section in the lower right of the main page of EVOsoft. This page also includes a blank Notes section 

where further notes can be added to the report from Microsoft Word if required.  
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Bar/Shape Plot Page 
This page shows the Bar or Shape plot of the selected recording(s), as shown on the Shape Plot tab 

of EVOsoft: 

 

BTB Histogram Page 
Available for Bar recordings only, this page shows the Bar-To-Bar Histogram for the selected 

recording(s), using the same resolution settings as shown on the BTB Histogram tab of EVOsoft: 
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Radial Plot Page 
This page shows the Radial Bar or Shape plot of the selected recording(s), as shown on the Radial 

Plot tab of EVOsoft: 

 

Bar Group Stats Page 
Available for Bar recordings only, this page shows the Bar Group Statistics for the selected 

recording(s), using the same Bar Group Size as shown on the Bar Group Stats tab of EVOsoft: 
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How to Generate a Report 
NOTE:  
You do not need Microsoft Word installed on your PC to generate reports. However, to open them 
you will need to either: 

• Have Microsoft Word 2007 or later either installed on your PC or available via an Office 365 
subscription, or 

• Have Microsoft Word 2003 or earlier with the “Microsoft Office Compatibility Pack” 
installed on your PC, or  

• Store the reports in OneDrive or Dropbox and then use Word Online to open them in any 
web browser, or 

• Store the reports on Google Drive and then open them using Google Docs, or by using the 
“Office Editing for Docs, Sheets & Slides” Chrome extension  

 
To generate a report: 

1. Select a recording (or multiple recordings) and display them in 

EVOsoft as normal. 

2. Right-click anywhere on any chart and select Generate Report….  

 

 

 

 

 

 

 

3. The Report Generator Options window will be 

displayed: 

 

 

 

 

 

Set the options as follows: 

Field Description 

Template To generate reports using the default layout, simply leave this field blank.  
However, if you wish to generate the report using a specific Word Template then 
select the relevant *.dotx file here.  

Refer to the Using a Microsoft Word Template for Reports  
section below for more information. 

Output Folder Specify the folder where generated reports should be saved to.  

Report Pages to 
Include 

Use these checkboxes to select which of the 5 different pages you want on the 
generated report. 

Heading If entered, the values entered in these 3 fields will appear at the top left of each 
page of the report e.g.  Subheading 1 
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Subheading 2 

 
 

Include Recording 
Comments & Notes 

If checked, any Recording Notes and Comments for the selected recording(s) will be 
included on the Recording Summary page of the report. If unchecked, then these 
fields will be omitted. 

Save these settings 
for next time 

If checked then the values entered for Heading, Subheading 1 and Subheading 2 will 
be saved so they appear again next time this window is displayed.  

Open Report If selected, then once the *.docx report file has been generated, it will be 
automatically opened in Microsoft Word (select this option only if you have Word 
installed on your PC) 

Show in Folder If selected, then the folder containing the generated report will be opened in 
Windows Explorer (select this option if you do not have Word installed on your PC).  

Report File Once the report has been generated, the full name of the resultant *.docx file will 

be displayed here. To open the file, click the … button to the right.  

 

When you have finished setting options, click Generate to generate the report and then open it in 

Microsoft Word.  

Managing Reports in Microsoft Word 
Once you have opened a report in Microsoft Word, you can then: 

• Edit the empty Notes section on the Recording Summary page to add any additional information 

you would like to appear on the report.  

• Cut-and-paste the report pages into other documents or applications. 

• Use Print to print out the report  

• Use Save As… to save the report in a different file format e.g. to  

o Save it in PDF format, or 

o Save it in the older *.doc format so it can be opened using Word 2003 or earlier, or 

• You can also use Export to convert the report to PDF or XPS formats so they can be more easily 

view by others without the need to have Word installed on their PC    

• Use Share to email the report (via Outlook) to other people using either: 

o A link to the file on OneDrive, or 

o In PDF format, or 

o In Word (*.docx) format   

NOTE: The menu options listed above may vary between versions of Microsoft Word.  
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Using a Microsoft Word Template for Reports 
If no Microsoft Word Template (*.dotx) file is specified on the Report Generator Options window, 

then the report pages will be generated with the default layout.  

However, you can use a custom Word Template file to alter the appearance of the generated report. 

For example, you can add standard page headers or footers, change the page margin sizes, or 

include your company logo on each page etc.  

NOTE: Using a Word Template will not change the information shown on each page on the report, 
only the overall visual appearance of the document. Refer to the Microsoft Word 
documentation/Help for more information on what is possible using Templates.  

 

Note that if you do use a Template file for report generation, then you may find that it changes the 

page layout such that the plot images shown on the Shape Plot, BTB Histogram etc pages now no 

longer fit on the same page as their corresponding headings, and instead get moved onto their own 

empty page. If this does occur, then you can adjust the size of these images as follows: 

1. Locate the directory where EVOsoft is installed  

The default location is C:\Program Files (x86)\Profiler Tech Ltd\EVOsoft 

2. In this directory, open the file Profilertech.EVOsoft.exe.config using Notepad 

3. Locate this setting: 

            <setting name="ReportChartImageHeight" serializeAs="String"> 

                <value>560</value> 

            </setting> 

This value defines the vertical size of each plot image and is expressed in ‘points’ (which are 

typically 1/72 of an inch).  

4. The default size is 560 points and so to reduce the plot image size, change this to a smaller value 

and save the Profilertech.EVOsoft.exe.config file 

5. Open EVOsoft, generate a trial report and verify if the images are now small enough to fit on the 

same page as their heading. 

6. If the image size is still not suitable, close EVOSoft and repeat the above 2 steps until you find a 

suitable size.   

  



   Copyright 2017 Profiler Tech Ltd  48 

32. Recording Notes 
When saving a recording on the MMS7000 you can 

optionally enter a Recording Note, either by entering 

it manually or by selecting from a predefined list. To 

modify this predefined list in EVOsoft, click MMS7000 

Device on the Toolbar and then select Recording 

Notes.  

Notes appear on the MMS7000 device in the same 

sequence as they are displayed in the window above, 

which you can change by clicking on an entry and 

using the Move Up and Move Down buttons. To add 

a new Recording Note, enter it in the New Note field 

and click Add. To delete an existing Recording Note, 

click on it and then click Delete. When you are 

finished, click OK 

 

 

. 

33. MMS7000 User Names 
Click MMS7000 Device on the Toolbar and then select 

User Names to maintain the list of MMS7000 user 

names that are available to select from when saving 

recordings.  

As for Recording Notes above, the sequence the User 

Names appear in the list on the MMS7000 is the same 

as they are displayed in the User Names windows in 

EVOsoft, which can be altered by selected a User Name 

and then clicking Move Up or Move Down.  
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34. Import / Export Data / Backup 
Importing Data into EVOsoft 
To import data into the database, click File → Import From..  

 

 
 

From this menu you can Import recordings from another EVOSoft Database, an existing Commtest 

Profiler MAS File or an MMS7000 File. A MMS7000 File means a .prt file copied directly from the 

StorageCard\Profilertech\Data folder on the MMS7000 device. 

Exporting Data out of EVOsoft 
To export recordings to another EVOsoft database: 

1. Select File→ Export To… → EVOsoft database…  

2. Use the Export to Database field to select the database to export to on the Export 

Recordings to… window: 

a. If you select an existing database, the recordings you select will be copied to that 

existing database, adding to whatever recordings it already contains. This is useful 

when you want to copy recordings from one database to another. 

b. If you Create a New Database, the selected recordings will be copied into their own 

new and otherwise-empty database. This is useful when you want to share only a 

small group of recordings with another EVOsoft user (see below) 

3. Use the Select Recordings section to pick the recordings to export.  

4. Finally, click Export Recordings. The selected recordings will then be copied to the target 

database, although note they will not also be deleted from the current database.  

Sharing recordings with other EVOsoft user.  

The simplest way to share a small group of recordings with another EVOsoft user is to export them 

to a newly-created database and then just email this new .sdf database file to the other user. Since 

you are sending them a normal EVOsoft database file, when they receive the file they can then 

either: 

1. Just open it directly in EVOsoft to view the recordings as normal (i.e. no special file 

conversion or import function is required), and/or 

2. If they want to add the recordings to one of their other existing EVOsoft databases, they can 

use the normal File → Import From… functionality, as described previously. 
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Database Backup  
EVOsoft databases are a single .sdf file, and so backups are done using a simple copy-and-paste of 

the .sdf file in Windows. 

NOTE: Always ensure EVOsoft is closed before attempting to copy a .sdf database file. 
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Troubleshooting 
Microsoft Outlook error message appears when the MMS7000 device is 

connected 
Some users may see the following message when connecting the MMS7000 device to their PC:  

 

This message appears because the 64-bit version of Microsoft Office is installed on the PC while the 

Windows communications utilities for the MMS7000 are expecting to find the 32-bit version. The 

message can be safely acknowledged and then ignored, and its appearance has no negative impact 

on the operation of the MMS7000 device and EVOsoft software. 

Unable to install Windows Mobile Device Center on Windows 7 & 8.1 
When attempting to install Windows Mobile Device Center on Windows 7 K or KN, or Windows 8 N 

or KN, you may receive the error message “The update could not be installed because at least one 

Windows component required by Windows Mobile Device Center is missing”. This is because 

Windows Mobile Device Center relies on some components of Windows Media Player, which is not 

installed by default on the K and KN versions of Windows. The add the missing components, first 

install the Microsoft Media Feature Pack for your version of Windows, and then try installing 

Windows Mobile Device Center again:  

Windows 7: https://www.microsoft.com/en-us/download/details.aspx?id=16546  

Windows 8.1: https://www.microsoft.com/en-us/download/details.aspx?id=40744  

Cannot establish Comms between EVOsoft and your MMS7000 Device 
1. Ensure that you have installed the required Microsoft device communication utility as described 

in Section 13. Installing Device Communication Utilities, above. 

2. Reset the MMS7000 by pressing and holding both the power button and the corresponding 

button on the other side of the keypad (see Figure 1: How to Hard Reset your MMS7000 device, 

below) for ~3 seconds until the display turns white, then release the buttons and waiting for the 

reboot process to complete. The Profiler App will automatically restart, and the Profiler should 

now be ready for use. 

3. Ensure that the MMS7000 device is fully initialised before connecting to your PC: 

a) Unplug the MMS7000 USB cable from your PC 

b) Press the Power button to put the MMS7000 device into Sleep mode.  

c) After a few seconds, press the Power button to wake it back up and wait until the 

Profiler7000 app main screen appears.  

d) Plug the MMS7000 back into a USB port on your PC 

https://www.microsoft.com/en-us/download/details.aspx?id=16546
https://www.microsoft.com/en-us/download/details.aspx?id=40744
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4. Ensure you have tried both connecting your MMS7000 to your PC before starting EVOsoft, and 

conversely starting EVOsoft and then connecting the device after.  

5. [If using Windows 10] Changes that are automatically installed as part of the Microsoft Windows 

10 “Creators Update” (and most subsequent Windows updates) can cause the connection to 

stop working. In such cases, your PC will detect that you have connected the MMS7000 to a USB 

port (by playing the normal ‘USB device connected’ sound), but the device does not appear in 

Windows File under ‘My Computer’. To resolve: 

a) Start the Windows Services Control Panel applet by pressing Windows+R, entering 

services.msc and pressing enter: 

 
b) Locate the service “Windows Mobile-2003-based device connectivity”, and double-click 

on it to view its properties. 

c) On the Log On tab, select ‘Local System account’ and then also ‘Allow service to 

interact with desktop’, and then click OK: 

 
Your MMS7000 device should now be correctly detected when next connected.  

6. [If using Windows 10] Ensure the correct version of Windows Mobile Device Center is installed: 

a) Go to Windows Start → Settings → Apps & Features… 

b) In the list of Apps, locate Windows Mobile Device Center, click on it and selected 

Uninstall: 
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c) Once the uninstall process has completed, restart your PC 

d) Download and install Windows Mobile Device Centre 6.1 (64-bit), available from 

https://www.microsoft.com/en-US/download/details.aspx?id=3182  

e) Apply the configuration changes to the “Windows Mobile-2003-based device 

connectivity” Windows Service, described above  

7. It is possible that the Windows driver has failed so try the following: 

a. Restart your PC 

b. With the handheld unplugged from the USB port, delete the device driver, and then plug 

the device back in.  

c. Verify that the device has been correctly detected by Windows by opening Windows File 

Explorer and ensuring that the device appears under ‘My Computer’ as an attached 

Windows CE Portable device. If the device is detected by Windows but not by EVOsoft it 

is still possible to import recordings manually: 

i. Open File Explorer and double-click the icon that represents the MMS7000 

device to view the files it contains. 

ii. Locate the ‘Storage Card’ folder on the device, and browse to the “…\Storage 

Card\Profilertech\Data” data folder 

iii. Copy all the .ptr files in this data folder to a location on your PC 

iv. Finally in EVOsoft, use the File → Import From… → MMS File... function to 

browse to the location of the .ptr files on your PC and import them into your 

EVOsoft database.  

  

https://www.microsoft.com/en-US/download/details.aspx?id=3182
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The PROFILER7000 app icon does not appear on the MMS7000 device 
Hard reset the MMS7000 device by pressing the power and the corresponding button on the other 

side of the device for ~3 seconds until the display turns white and then releasing the buttons and 

waiting for the reboot process to complete: 

 

Figure 1: How to Hard Reset your MMS7000 device 

Date and Time on the MMS7000 must be constantly updated 
As described above in Connecting Your MMS7000 to your PC, when you first connect your 

MMS7000 device you are given the option of creating a “Sync Partnership” with the device. If you do 

so, then each time you connect your MMS7000 to your PC its date and time will be automatically 

updated. If you did not choose to create a Sync Partnership initially then you will need to recreate 

the connection to the MMS7000 as follows:  

1. Disconnect your MMS7000 from your PC 

2. Go to Control Panel → All Control Panel Items → Sync Center, and locate the current 

partnership with your MMS7000: 

 
3. Right-click on the partnership entry and select Delete.  

Reconnect your MMS7000 and then follow the steps described in Connecting Your MMS7000 to 

your PC, ensuring that you choose the option of creating a Sync Partnership this time.  

MMS7000 battery goes flat even when the device is powered off 
The MMS7000 is based on the Microsoft Windows CE operating system, which has a limitation in 

that when you press the Power button , it only puts the device into a ‘Sleep Mode’ rather 

than powering it off entirely. In this mode, the device is still using a very small amount of battery 

power and if left in this state the battery will eventually go flat (typically in 5-7 days). If you don’t 
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plan to use your MMS7000 for an extended period, you can completely power it off to conserve the 

battery as follows: 

Step Display 

Tap on the System Menu icon in the top left corner 
of the Home Screen:  

    
 

Tap on the Power Off menu entry 
 

 
 

 

Technical Support 
For technical support please contact  

Support@profilertech.com 

Or visit us on the web at 

www.profilertech.com  

mailto:Support@profilertech.com
http://www.profilertech.com/

